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[单元学习内容] 

 知识目标： 
了解虚拟机的应用场合 
了解常见虚拟机的工作原理和使用方法 
掌握虚拟机的创建步骤 
了解虚拟机的保存形式 
掌握网络连接中桥接的设置方法 
了解虚拟机快照的应用 

 能力目标： 
具备安装虚拟机软件的能力 
具备使用 VMware Workstation创建虚拟机的能力 
具备使用 VMware Workstation打开虚拟机的能力 
具备配置 VMware Workstation虚拟机网络环境的能力 
具备使用 VMware Workstation快照功能保存虚拟机实时状态的能力 

 情感态度价值观： 
具备独立思考、学习和与人团结协作的能力 
具备组建网络的成本意识 
具备良好的职业道德与科学的工作态度 

[单元学习目标] 

计算机网络技术飞速发展，服务器技术日新月异。更加低廉且高效的生产环境成为

众多企业的必然选择，虚拟机化技术的出现使得这些问题迎刃而解。基于虚拟机平台，

网络管理人员可以再虚拟出多台计算机资源，从而减少了硬件投入。 
本单元将介绍虚拟机软件 VMware Workstation的使用，包括虚拟机的创建、修改、

打开、删除等操作，并且指导读者在独立的物理机上构建连通的虚拟机环境，为后续配

置各种应用服务器做出铺垫。 

 任务 1  初识虚拟机 

【任务描述】 
迈普公司新成立不久，是典型的中小型企业，小王是该公司新入职的系统管理员，

该公司目前并未购买单独的硬件服务器产品，只给小王配发了一台高性能 PC，小王在

互联网上看到可以使用虚拟机来实现多台虚拟服务器，进而逐步部署公司的网络服务，

小王决定尽快熟悉虚拟机。 
【任务分析】 
小王通过在互联网上查找和学习，决定先把虚拟机的概念理解明白，再看看现在主

流的虚拟机软件都有哪些，以便今后在自己的机器上安装和使用虚拟机。 
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【任务实战】 
1．什么是虚拟机？ 
虚拟机的概念有两种：一种是“虚拟出来的计算机”，另外一种是类似 Java提供硬

件和编译软件之间的“运行时环境”。我们这里所说的虚拟机，是通过软件模拟的具有

完整硬件系统功能、运行在一个完全隔离环境中的完整计算机系统。通过虚拟机软件，

你可以在一台物理计算机上模拟出一台或多台虚拟的计算机。虚拟机软件“虚拟”出来

的计算机和物理计算机（下文简称为“物理机”）一样，具有自己的计算机硬件，包括

主板、CPU、硬盘、光驱、网卡、显示卡、声卡等。虚拟机和物理机一样，能够安装操
作系统和应用软件，能够提供网络应用和服务。 

2．为什么要使用虚拟机？ 
使用虚拟机的主要原因有两个：一是在生产环境中使用；二是在实验环境中使用。 
在生产环境中使用，是指把一台服务器作为多台服务器来使用，减少硬件投入，同

时增加了服务器的可整合性。新开发的软件需要做软件测试可以在虚拟机下进行，企业

为了便于服务器的迁移也可以将系统和服务运行在虚拟机上，这样软件测试和服务迁移

不会影响物理机，同时又节约企业运营成本。 
在实验环境中使用，是指通过虚拟机软件平台可以虚拟出多个系统来做实验，而不

会破坏物理机设置。实验环境大多应用于学校的学习环境中，对于学生和网络爱好者来

说，可以虚拟出多台计算机用于网络互联、网络安全等实验，在有限的条件下实现了更

为复杂的网络环境。 
3．使用何种虚拟机软件？ 
虚拟机软件是指能够模拟出虚拟机的软件平台。 
目前 VMware、Microsoft、Oracle等公司均提供了满足于企业应用的虚拟机软件产

品。目前应用较多的有 VMware 公司的 VMware Workstation、VMware ESX Server、
VMware GSX Server、免费的 VMware Server，Microsoft公司的 Virtual PC、Hyper-V，
Oracle公司的 Oracle VM VirtualBox等，其中 VMware公司的产品市场占有率较高。 

VMware公司的 VMware Workstation比免费的 VMware Server功能更为强大，可以
创建更多的虚拟机快照。目前 VMware Workstation 使用较多的版本是 VMware 
Workstation 6.0、VMware Workstation 6.5，当前最新的版本 VMware Workstation 10.X系
列，更新的版本除增加和修正一些功能之外，主要是增加了对新系统和硬件的支持，比

如 Windows Server 2008、Windows 8、Red Hat Enterprise Linux 6等。 
小王根据自身情况，考虑到学习资料的可获得性和易用性，决定选用 VMware 

Workstation 6.5作为自己的入门学习环境。 
【任务拓展】 

一、理论题 

1．请说明 Java虚拟机和 VMware虚拟机的区别。 
2．虚拟机的用途有哪些？ 
3．虚拟机的优点有哪些？ 
4．主流的虚拟机软件有哪些？ 
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二、实训 

1．上网学习：了解 VMware ESX Server、VMware GSX Server的主要区别。 
2．上网学习：了解 Microsoft Hyper-V的运行环境。 

 任务 2  VMware Workstation 系统

基本安全设置 

【任务描述】 
网络管理员小王已经完成了对虚拟机的初步学习，准备在自己的物理机上安装虚拟

机平台 VMware Workstation 6.5，以便在该虚拟机环境中完成更多的工作。 
【任务分析】 
获取 VMware Workstation 6.5软件可以通过 VMware的经销商购买该软件，或者通过

互联网到 VMware 官方网站（http://downloads.vmware.com/d/）、华军软件园、多特软件
站等网上下载 30天试用版。VMware Workstation 6.5支持Windows和 Linux操作系统环
境，小王决定在自己的Windows XP物理机中安装 VMware Workstation 6.5.3。 

【任务实战】 
1．安装 VMware Workstation 6.5到默认安装目录中。 

 知识链接  

● VMware Workstation 6.5 主要新功能。 
1．提供对多种 32 位/64 位 Windows/Linux 客户端的虚拟支持。 
2．更强大的录制和回放客户端（快照功能）的支持。在需要的情况下可以对虚拟

机的操作录制视频，通过此功能还可以在虚拟机运行时创建某个运行时间点的“快照”，

在“快照管理器”中可通过缩略图方式查看已创建的多个快照，随时恢复到某一快照的

系统状态，方便了对系统运行时状态的记录，使得对状态的还原和演示更加灵活。 
3．虚拟机流的支持。在创建和还原快照的过程中，即可打开相关的虚拟机应用。 
4．Linux 下具备图形化的安装包和图形界面的虚拟网络编辑器。 
6．文件共享/拖曳文件时性能的增强。 
7．对 Windows XP 客户端的 3D 加速支持，能够满足游戏的需要。 
8．新增的 Unity 功能可以使虚拟机中的应用程序转到物理机系统中运行，物理机

会有 Application Menu，更加灵活地调用虚拟机中的应用程序，增强了虚拟机和物理机

的融合。 
9．无人值守安装。在使用虚拟机过程中，往往要频繁地重新安装操作系统，无人

值守安装向导可以存储 ISO 镜像位置、产品安装序列等安装参数。简化了 Windows XP、
Windows Server 2003 等操作系统的安装过程，提高了管理员的工作效率。 
（1）运行 VMware Workstation 6.5安装程序，如图 1-2-1所示。 
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（2）安装程序运行之后，会自动检测当前的系统环境，然后弹出安装向导的欢迎界
面，如图 1-2-2所示，单击“Next”按钮。 

    

图 1-2-1  运行安装程序                 图 1-2-2  安装向导欢迎界面 

（3）在安装类型选择界面，选择“Typical”（典型安装），如图 1-2-3所示。此处如
果选择“Custom”（自定义安装）则可以自定义安装组件、安装位置等。本任务中，选
择“Typical”，然后单击“Next”按钮。 
（ 4）选择安装位置，默认安装位置为“ C:\Program Files\VMware\VMware 

Workstation”，如需要更改安装位置则单击“Change”按钮，此处选择默认安装位置，
如图 1-2-4所示，单击“Next”按钮。 

    

图 1-2-3  选择安装类型                         图 1-2-4 选择安装位置 

（5）选择快捷方式创建方式，默认会在桌面、快速启动栏、程序中创建快捷方式，
选择默认即可，如图 1-2-5所示，单击“Next”按钮。 
（6）在安装程序准备界面，如图 1-2-6所示，单击“Install”按钮进行安装。 
（7）在注册信息界面“User Name”输入用户名、“Company”处输入公司名称、“Serial 

Numbe”处输入序列号，如图 1-2-7所示，输入完成后单击“Enter”按钮。如果没有软
件的序列号，则可以单击“Skip”按钮跳过，选择使用 30天。 
（8）安装完成会有安装完成提示界面，如图 1-2-8 所示，单击“Finish”按钮完成

VMware Workstation 6.5的安装。 
（9）软件安装完成后需要重启操作系统完成设置的更改，如图 1-2-9所示，在弹出
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的重启提示窗口单击“Yes”按钮。 

    

图 1-2-5  选择快捷方式                   图 1-2-6  安装程序准备就绪 

    

图 1-2-7  注册信息                             图 1-2-8  安装完成 

 

图 1-2-9  安装完成后的重启窗口 

【温馨提示】 

1．VMware 官方没有推出 VMware Workstation 6.5 的中文版，需要中文软件界面的读者可

在互联网上自行搜索对应具体版本的汉化包，如 VMware Workstation 6.5.3 和 6.5.5 会有所不同。

汉化包是由 VMware 爱好者来完成的，某些界面的汉化存在未完全汉化及少量的错误之处。 

2．在安装 VMware 的过程中，会向系统中添加系统服务，并且修改开机启动项。安装了 360

安全卫士、QQ 电脑管家等防护软件的计算机要注意对相应服务的“允许”，如图 1-2-10 所示。 

2．运行 VMware Workstation 6.5。 
（1）在桌面上双击“VMware Workstation”图标启动 VMware Workstation 6.5，在

“License Agreement”窗口选择“Yes，I accept the terms in the license agreement”同意
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VMware公司的许可协议，如图 1-2-11所示，单击“OK”按钮。 

     

图 1-2-10  防火墙提示                      图 1-2-11  同意许可协议 

（2）进入 VMware Workstation主窗口，如图 1-2-12所示。 

 

图 1-2-12  VMware Workstation主窗口 

【任务拓展】 

一、理论题 

1．VMware Workstation 6.5有哪些新功能？ 
2．VMware Workstation快照保存的是什么？ 

二、实训 

1．从 VMware官方网站下载 VMware Workstation 6.5.3，并且下载对应的用户手册。 
2．安装 VMware Workstation 6.5到计算机上。 
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 任务 3  使用虚拟机平台 

活动 1  创建一台虚拟机 

【任务描述】 
小王已在自己的计算机上安装了 VMware Workstation 6.5，准备创建一台虚拟机来

一试身手。 
【任务分析】 
VMware Workstation的操作和其他软件类似，完成某一操作有菜单和按钮两种操作

方式。在本任务中，小王利用 VMware Workstation的“File”菜单、“New Virtual Machine”
按钮来创建一台虚拟机。 

【任务实战】 
1．使用菜单采用“Typical”（典型）方式创建一台虚拟机。 
（1）在 VMware Workstation主窗口，依次执行“File”→“New”→“Virtual Machine”

命令，如图 1-3-1所示。 
（2）在弹出的虚拟机创建向导界面，选择“Typical”（典型）方式创建一台

“Workstation 6.5”格式的虚拟机，如图 1-3-2所示，然后单击“Next”按钮。 

   

图 1-3-1  使用菜单创建一台虚拟机                 图 1-3-2 虚拟机创建向导 

【温馨提示】 

● WMware 版本对使用虚拟机的影响。 

在 VMWare Workstation 5 及其以前的版本中，VMWare Workstation 虚拟机的每次升级，

都只能将低版本的虚拟机文件一次性升级到高版本的虚拟机中，高版本带有向下兼容功能，能够

读取使用低版本创建的典型虚拟机，但低版本则不能读取高版本创建的典型虚拟机。 

在某些企业环境中，需要使用低版本虚拟机软件读取高版本创建的虚拟机。方法一是使用

图 1-3-2 中的“Custom”选项创建与低版本相对应的虚拟机格式；方法二是使用 VMWare 
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Workstation 6.5 提供的转换工具，可以将虚拟机在不同版本之间进行转换（可以在 VMWare 

Workstation 4.x、5.x、6.x 其兼容的产品中进行转换），具体操作步骤如下。 

（1）选择“VM”→“Upgrade or Change Version”命令。 

（2）在欢迎界面中单击 “Next”按钮，进入“Change Version Wizard”对话框，在 Hardware 

Compatibility 下拉列表中选择需要的版本，然后单击“Next”按钮。 

（3）选中“Alter this Virtual Machine”单选按钮，然后单击“Next”按钮。 

（4）转换完成后，可查看虚拟机的硬件版本，已经转换完成。 

（3）选择客户操作系统安装介质，安装介质来源可以选择“Installer disc”，使用物
理光驱来为虚拟机安装系统，如果有操作系统镜像则可以选择“Installer disc image file
（ISO）”，也可选择“I will install operating system later”忽略安装介质以后再选择，在
本任务中，选择“I will install operating system later”以后再安装系统，如图 1-3-3所示，
然后单击“Next”按钮。 

 

图 1-3-3 客户操作系统安装介质 

（4）选择虚拟机操作系统版本，VMware支持多种主流操作系统，包括 Windows、
Linux、Netware、Solaris等，只需在支持系统的下拉列表中选择即可。本任务中小王要
安装 Windows Server 2003企业版，此处选择 Windows Server 2003 Enterprise Edition，
如图 1-3-4所示，然后单击“Next”按钮。 
（5）在虚拟机名称和存储位置窗口输入虚拟机的名字，并选择虚拟机的存储位置，

如图 1-3-5所示。默认的虚拟机名称为操作系统名称，存储位置位于“我的文档”的“My 
Virtual machines”下，如果用户更改了“我的文档”的缺省位置则虚拟机的存储路径随
之移动，使用默认名称和存储位置即可，然后单击“Next”按钮。 
（6）在磁盘空间大小窗口的“Maximum disk size（GB）”中输入虚拟机磁盘的最大

空间。 
（7）在虚拟机创建汇总窗口，可以看到虚拟机的信息汇总，如图 1-3-7所示，虚拟

机的名称、存储位置、版本、操作系统、磁盘、内存、网卡、其他设备等信息。如果用
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户需要更改硬件配置，如网卡模式、内存大小等可以单击“Customize Hardware”来实
现，如果不需要更改，则单击“Finish”按钮。 

    

图 1-3-4 客户机（虚拟机）操作系统选择            图 1-3-5 虚拟机名称和存储位置 

    

图 1-3-6 虚拟机磁盘空间大小                    图 1-3-7 虚拟机信息汇总 

【温馨提示】 

● 如何配置虚拟磁盘。 

VMware Workstation 6.5 之后创建的虚拟机采用动态磁盘大小方式，用户只需限定虚拟机的

最大磁盘空间即可，存储数据量小于最大磁盘空间时采用动态存储，即“用多少占多少”。 

虚拟机的默认磁盘文件为一个文件，便于用户识别和使用。如果用户使用存储容量小于磁

盘容量（实际存储数据的磁盘空间）的移动介质复制虚拟机时，VMware Workstation 为用户提

供了磁盘切割方案，每 2GB 切割为一个磁盘文件。读者可根据需要选择是否对磁盘文件进行

切割。 
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（8）在图 1-3-7中默认选中了“Power on this virtual machine after creation”，因而创
建完成之后，虚拟机会自动启动，如图 1-3-8所示，由于此前未选择操作系统安装介质
（参见图 1-3-3），虚拟机中硬盘中又没有系统，软件虚拟机启动后会从网卡启动之后会
提示“Operating System not found”的未找到操作系统信息。更改虚拟机安装介质，修
改虚拟机可参见下次任务。 

 

图 1-3-8 虚拟机启动 

2．使用按钮采用“Custom”（自定义）方式创建一台虚拟机为工作用母机。 
（1）在图 1-3-9中单击“New Virtual Machine”按钮。 

 

图 1-3-9 VMware Workstation主窗口 

（2）在虚拟机创建向导界面选择“Custom（advanced）”（自定义（高级）模式），
如图 1-3-10 所示，然后单击“Next”按钮。在自定义模式的向导中，将会出现让用户
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修改虚拟机硬盘、内存、网卡等选项的窗口，可以根据需要自行调整设置。 
（3）选择虚拟机的硬件版本，本任务选择 Workstation 6.5，如图 1-3-11所示，然后

单击“Next”按钮。VMware Workstation 6.5默认的虚拟机格式可以在与 6.5或以上版
本的 VMware家族产品中打开，如果用户创建的虚拟机今后可能在 VMware Workstation 
6中打开，则需要选择 6.0的虚拟机版本，虚拟机版本越低，支持虚拟硬件就越少。 

       

  图 1-3-10 虚拟机创建向导-自定义方式          图 1-3-11 选择虚拟机的硬件版本 

（4）接下来需要选择安装介质位置，本任务中选择使用镜像（安装盘的 ISO 镜像
文件）来安装操作系统，如图 1-3-12 所示，单击“Browse”按钮选择操作系统镜像的
位置，VMware Workstation 6.5会自动检测镜像是否支持“Easy Install”无人值守安装
模式，如果支持则会在界面中提示，则后续步骤中就无须再选择操作系统类型，自动识

别为 Windows Server 2003 Enterprise Edition，单击“Next”按钮继续。 
（5）由于小王要安装的 Windows Server 2003在“Easy Install”支持列表之中，会

出现无人值守安装模式的必要信息，如序列号、计算机用户名、密码等，如图 1-3-13
所示，如果在此处不输入这些信息直接单击“Next”按钮跳过，VMware Workstation 6.5
会再次弹出两个对话框询问用户是否继续，单击“Yes”按钮选择继续即可。 

    

图 1-3-12 选择安装介质           图 1-3-13 “Easy Install”无人值守安装模式 

（6）接下来输入虚拟机的名称，此次小王输入了一个易识别的名称“2003test”，如
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图 1-3-14所示，虚拟机的存储位置在 2003test目录下，然后单击“Next”按钮。 
（7）输入 CPU个数，如图 1-3-15所示，单击“Next”按钮继续。如果物理机 CPU

是双核心产品，则 VMware Workstation支持单/双 CPU模式。 

    
  图 1-3-14  虚拟机名称和存储位置             图 1-3-15  选择 CPU个数 

（8）接下来输入内存的大小，如图 1-3-16 所示。此窗口有三个三角形图标，黄色
三角形（左数第一个）表示虚拟机系统所需的最小内存；绿色三角形（左数第二个）代

表当前内存大小，可以根据虚拟机系统类型适度调整内存大小；蓝色三角形（左数第二

个）当前系统可用的最大剩余内存容量，用户设置的内存大小不能超过此数值。本任务

中使用 512MB内存，然后单击“Next”按钮。 
（9）网络链接类型可以根据虚拟机的实际用途作出选择，在生产环境中使用较多的

是“Use Bridged Networking（使用桥接网络）”和“Use Network Address Translation（NAT）
（使用网络地址转换 NAT）”，本任务选择“Use Net work Address Transkation（NAT）”，如
图 1-3-17所示，然后单击“Next”按钮。 

       
图 1-3-16  选择内存大小                   图 1-3-17  网络连接类型 

 知识链接  

VMware workstation 6.5 在安装过程中，会在物理机上安装两块虚拟网卡，分别是

VMnet1 和 VMnet8。在 VMware workstation 中，默认有 3 个虚拟交换机，分别是 VMnet0
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（使用桥接网络）、VMnet1（使用主机网络）和 VMnet8（使用网络地址转换）。虚拟网

卡 VMnet1 和 VMnet8 默认启动，一般无须更改。如要使用，必须根据网络的需要做出

相应的更改，否则会影响网络的连通。4 种网络链接类型的作用如表 1-3-1 所示。 
表 1-3-1  网络连接属性意义 

网络连接类型 虚拟交换机 网络连接意义 

Use Bridged Networking 

（使用桥接网络） 
VMnet0 

网络上的一台独立计算机，与物理机在同一个交换环境

中，地址在同一个网段即可 ping通 

Use Network Address Translation（NAT） 

（使用网络地址转换） 
VMnet8 

虚拟机使用物理机的 VMnet8 网卡地址作为网关单向访

问网络上的其他计算机（包括 Internet） 

Use Host-Only Networking 

（使用主机网络） 
VMnet1 

此时虚拟机只能与物理机互连，不能访问网络上其他计

算机 

Do not use a network connection 

（无网络连接） 
 虚拟机中没有网卡，相当于单机使用 

（10）选择 I/O适配器类型，如图 1-3-18所示，采用默认设置即可，然后单击“Next”
按钮。 
（11）接下来选择一个磁盘，如图 1-3-19所示，如果是新建的一台虚拟机将要安装

新的操作系统则选择“Create a new virtual disk”创建一个新的磁盘；如果读取已有的
磁盘则选择“Use an existing virtual disk”选则一个已经存在的磁盘，此项设置使用于原
有虚拟磁盘中存在数据，只是变更虚拟机硬件或者其他设置，或者是需要读取有其他虚

拟机软件（如 Oracle VM VirtualBox）创建虚拟机的磁盘文件。本任务是要创建一台虚
拟机准备安装系统，故选择“Create a new virtual disk”，然后单击“Next”按钮。 

    

图 1-3-18  I/O适配器类型                       图 1-3-19  磁盘选择 

（12）在图 1-3-20 所示的图中，选择虚拟磁盘接口类型，可以选择 IDE 类型或者
SCSI类型，如果需要在虚拟机中实现 SCSI硬盘的磁盘阵列功能，则需要选择 SCSI类
型，本任务中选择 SCSI类型以方便完成今后的工作任务，单击“Next”按钮继续。 
（13）接下来输入虚拟磁盘空间的大小，如图 1-3-21所示，VMware Workstation会

根据操作系统类型为用户推荐一个存储空间大小（此大小往往是该系统运行和使用的较
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小空间），本任务小王选择 20GB的最大磁盘空间，单击“Next”按钮继续。 

    
图 1-3-20 选择虚拟磁盘接口类型            图 1-3-21 输入虚拟磁盘的大小 

（14）在虚拟磁盘命名窗口中，VMware Workstation会使用虚拟机名称作为磁盘名
称，如图 1-3-22 所示，这样命名便于用户对虚拟机硬盘的识别，这里选择默认，单击
“Next”按钮继续。 

（15）虚拟机创建完成之前会再次确认虚拟机的各项硬件信息，如图 1-3-23所示，
单击“Finish”按钮完成虚拟机 VMware Workstation的创建。 

      
图 1-3-22 虚拟磁盘文件名称                  图 1-3-23 虚拟机信息汇总 

【任务拓展】 

一、理论题 

1．使用 VMware Workstation 6.5创建的典型虚拟机是否能在 VMware Workstation 
5.5下打开？ 

2．什么是磁盘镜像？ 
3．虚拟机的磁盘选项中，“Maximum disk size（GB）”表示什么？ 
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4．用户创建的虚拟机存储在物理机 D 盘，物理 D 盘容量为 40GB，能否创建
“Maximum disk size（GB）”为 60GB的虚拟机？ 

5．VMware Workstation的 4种网络连接类型有何不同？分别适用于何种网络环境？ 

二、实训 

1．使用菜单创建一台典型虚拟机，虚拟机操作系统类型为 Windows Server 2003 
Enterprise Edition，存储位置采用默认设置。 

2．使用按钮在物理机上创建一台 Windows Server 2003虚拟机，虚拟机硬件为自定
义模式，虚拟机名称为 2003test，磁盘空间为 20GB，网卡使用 NAT模式，存储在 D:\My 
Virtual Machines目录下。 

活动 2  修改虚拟机硬件配置 

【任务描述】 
小王准备创建一个 Windows Server 2003 虚拟机母机方便今后使用，创建完成之后

发现虚拟机并不需要软盘驱动器，且网卡的网络连接类型默认为 NAT，需要对虚拟机

硬件配置作适当修改。 
【任务分析】 
可以通过 VMware Workstation来编辑已创建的虚拟机，通过主窗口的“Edit virtual 

machine settings”可以完成硬件的添加、删除、修改等操作。 
【任务实战】 
1．添加/删除虚拟机设备 
（1）删除虚拟机软盘驱动器 
现在软盘驱动器（Floppy）已基本无人使用。小王在今后的工作中也不会再用到虚

拟机的软盘驱动器，故将其删除。在图 1-3-24所示的 VMware Workstation主窗口中单击
“Edit virtual machine settings”，在弹出的虚拟机设置窗口中选中“Floppy”，如图 1-3-25
所示，单击“Remove”按钮，再单击“OK”按钮即可删除软盘驱动器。 

   
图 1-3-24  编辑虚拟机设置                图 1-3-25 删除虚拟机的软盘驱动器 

【温馨提示】 
删除虚拟机的其他硬件可参照删除软盘驱动器的方法。在实际应用过程中，除非要替换的

虚拟机硬盘带有可引导的操作系统，否则删除虚拟机的可引导硬盘会造成虚拟机因找不到操作系
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统而无法启动。 

其中内存、显示设置、处理器（Memory、Display、Processors）不能删除，只能做相应的修改。 

（2）为虚拟机添加一块新硬盘。 
因拓展虚拟机存储容量、做磁盘阵列操作等需要添加一块新的虚拟机硬盘的情况，

可以在图 1-3-25所示的窗口中单击“Add”按钮，在弹出的图 1-3-26所示窗口中选择“Hard 
Disk”，然后单击“Next”按钮；在图 1-3-27中选择“Create a new virtual disk”单选按
钮，添加一个新创建的磁盘后单击“Next”按钮；接下来在图 1-3-28 中选择磁盘的接
口类型为“SCSI”，然后单击“Next”按钮；在图 1-3-29中输入新添加硬盘的容量后单
击“Next”按钮；接下来在如图 1-3-30所示的图中会出现两块 Hard Disk，单击“OK”。
按钮。即可完成新硬盘的添加。如要添加其他设备，可参照此方法。 

   

  图 1-3-26  添加虚拟机硬盘                    图 1-3-27  创建一个新的磁盘 

    

图 1-3-28  选择磁盘接口类型                     图 1-3-29  选择磁盘容量 
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图 1-3-30  添加新硬盘完毕 

【任务拓展】 

一、理论题 

请说出 VMware Workstation 6.5支持的虚拟磁盘接口类型？ 

二、实训 

1．删除虚拟机的软盘驱动器。 
2．为虚拟机添加一块新的硬盘，磁盘空间大小为 8GB，接口类型为 SCSI。 
3．修改虚拟网卡的网络连接模式为桥接。 
4．修改虚拟机内存为 800MB。 

活动 3  打开一台虚拟机 

【任务描述】 
小王创建了多台虚拟机，现在准备打开其中的一台虚拟机。 
【任务分析】 
可以使用菜单、主界面上的向导按钮和虚拟机存储目录双击.vmx 文件的方式打开

已经存在的虚拟机。 
【任务实战】 
1．打开一台存在的虚拟机可以使用以下方法。 
（1）使用按钮方式打开。在 VMware Workstation的主界

面中，选择“Home”选项卡，单击“Open Existing VM or Team”
图标，如图 1-3-31 所示，然后在打开的“打开”对话框中选
择虚拟机的存储路径，如图 1-3-32所示，打开.vmx为扩展名
的虚拟机配置文件即可打开虚拟机。 
（2）使用菜单方式打开。选择“File”→“Open”命令，然后弹出如图 1-3-32所示

 

图 1-3-31  打开虚拟机 
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的窗口，选择.vmx文件即可。 

 

图 1-3-32  “打开”对话框 

（3）如果计算机中安装了 VMware Workstation，也可以在虚拟机的存储目录下，双
击.vmx为扩展名的虚拟机配置文件打开虚拟机。 

2．启动虚拟机。 
可在 VMware Workstation主窗口中选择要启动的虚拟机（切换至该虚拟机选项卡），

如图 1-3-33所示，单击工具栏中的 图标或“Commands”窗口中的“Power on this virtual 
machine”即可完成启动。也可在“Sidebar”窗口中的“Favorites”菜单中选择虚拟机，
然后使用右键菜单的“Power on”命令启动虚拟机。 

 

图 1-3-33  打开虚拟机 
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【任务拓展】 

一、理论题 

1．虚拟机文件的扩展名是什么？ 
2．通过几种方式可以打开存在的虚拟机？ 

二、实训 

打开一台已经存在的虚拟机。 

活动 4  配置虚拟机网络环境 

【任务描述】 
小王有时会因工作需要而断开计算机的网络连接，造成了正在使用的虚拟机和物理机

无法进行通信。小王的计算机只有一块物理网卡，每次都要找一根网线将物理机与公司交

换机连接以便激活“本地连接”完成自己的任务，来回插拔网线让小王非常头疼。 
【任务分析】 
解决小王遇到的问题可以从两个方面入手，一是确保小王使用虚拟机做实验或其他

工作时“本地连接”处于启用状态，或者是通过增加一块“回环测试网卡”来保持至少

有一个网络连接处于启用状态。 
【任务实战】 
在 VMware Workstation 使用的过程中，程序本身会将虚拟机的网卡桥接到物理机

的“活动网卡”上，首选“本地连接”，其次是其他活动（“已连接”状态）的网卡。但

在某些生产环境中，物理机的网络连接都是断开的，这种状况会造成 VMware 
Workstation的自动桥接功能失效，虚拟机无法与物理机完成通信。 

在使用笔记本电脑时，网络连接大多使用的是“无线网络连接”环境，无线网卡的

IP地址是 AP自动分配的。如果有线网卡“本地连接”是断开的，则 VMware Workstation
会将虚拟机自动桥接到“无线网络连接”，无线网络的可移动性造成了用户需要频繁修

改虚拟机或物理机的 IP地址，以便完成网卡的桥接。 
为了在物理机没有物理网络连接的情况下完成虚拟机与物理机的通信，可采用“回

环测试网卡”来实现，此网卡无须物理网络即可连通，添加了此网卡的作用是让物理机

总有一块网卡是“活动网卡”，方便了虚拟机与物理机的桥接通信。Windows 系统提供
了此项功能。 

1．在物理机上添加回环测试网卡。 
（1）依次打开“控制面板”→“添加硬件”，在如图 1-3-34所示的欢迎界面中单击

“下一步”按钮。 
（2）在硬件连接状态窗口，如图 1-3-35所示，选择“是，我已经连接了此硬件”，

然后单击“下一步”按钮。 
（3）选择“添加新的硬件设备”，如图 1-3-36所示，然后单击“下一步”按钮。 
（4）在安装类型中选择“安装我手动从列表选择的硬件（高级)”，如图 1-3-37所示，

然后单击“下一步”按钮。 
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图 1-3-34  添加硬件向导                       图 1-3-35  硬件连接状态 

    

图 1-3-36  添加新的硬件设备                    图 1-3-37  硬件向导安装类型 

（5）在“常见硬件类型”对话框中选择“网络适配器”，如图 1-3-38所示，然后单
击“下一步”按钮。 
（6）选择“厂商”为“Microsoft”，“网卡”为“Microsoft Loopback Adapter”，如

图 1-3-39所示，然后单击“下一步”按钮。 

    

图 1-3-38  列表中选择“网络适配器”   图 1-3-39  选择 Microsoft Loopback Adapter 

（7）在如图 1-3-40 所示对话框中单击“下一步”按钮，在图 1-3-41 所示对话框中
单击“完成”按钮，即可完成回环测试网卡的安装，在图 1-3-42 所示的对话框中可以
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看到添加完成的回环测试网卡“Microsoft Loopback Adapter”。 

    

图 1-3-40  安装准备                        图 1-3-41  添加硬件完成 

 

图 1-3-42  回环测试网卡启动 

【温馨提示】 

● 使用回环测试网卡。 

使用回环测试网卡可方便在 VMware Workstation 虚拟机环境中的实验和工作，但使用不当

会造成物理机无法连接外网。使用无线网络连接的读者需要注意，在物理网络连接的断开情况下，

使用回环测试网卡与虚拟机桥接通信时需要配置 IP 地址。在关闭虚拟机环境后，再使用笔记本

的无线网络连接上网的时候，出现无法访问外网的情况，这是由于回环测试网卡若配置了网关，

或是无线网络连接的网关构成了“双网关”造成的，所以如果物理机的回环测试网卡不需要网关

即可完成相关任务，此处可不填网关。 

如果物理机有“永久连接”的物理网卡，则不需要使用回环测试网卡，以免给自身增加工

作任务的难度。 

2．配置虚拟机网络桥接。 
在 VMware Workstation主窗口中依次选择“Edit”→“Virtual Network Editor”，进入

虚拟网络编辑器，如图 1-3-43所示，切换到“Host Virtual Network Mapping”，选项卡在
“VMnet0”后面的下拉列表中可以看到“Bridged to an automatically chosen adapter”自动桥
接到活跃网卡，默认是由上而下的顺序选择桥接，也可以手动设置要桥接到哪块网卡。小
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王为了方便自己的学习，桥接到了刚刚创建的回环测试网卡“Microsoft Loopback Adapter”。 

 

图 1-3-43  虚拟网络编辑器 

【任务拓展】 

一、理论题 

1．Windows系统中回环测试网卡的功能是什么？ 
2．在 Windows系统中能否创建多个回环测试网卡？ 
3．回环测试网卡是否可以处于“永久连接”状态？ 

二、实训 

1．在物理机中添加一块回环测试网卡。 
2．修改 VMware Workstation 的网络桥接模式，手动桥接到一个已启用的物理网

卡上。 

活动 5  使用快照功能保存虚拟机实时状态 

【任务描述】 
小王目前边工作边学习，希望在工作过程中能够保留虚拟机某些时段的配置状态，

以便反复研究和学习。 
【任务分析】 
可以通过 VMware Workstation自带的快照（Snapshot）功能来保存虚拟机在某个时

间点的状态。 
【任务实战】 
VMware Workstation提供了对虚拟机实时状态的存储（快照）功能，利用快照功能

可以保存系统多个时间点的状态，方便了工作中对服务器状态的控制，同时也便于网络

爱好者学习网络操作系统时保存相应的步骤。 
VMware Workstation 提供的快照功能，可以通过“VM”→“Snapshot”来创建、

还原、管理快照，也可使用按钮来操作。 
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 知识链接  

● VMware Workstation 快照按钮功能。 
如图 1-3-44 所示，使用“创建快照”按钮来创

建快照，“还原快照”按还原至最近的快照点，“快

照管理器”则可以创建快照并还原至所创建的任意

快照点。 
1．创建快照。 
依次选择“VM”→“Snapshot”→“Take Snapshot”，然后输入快照的名字和注释，

如图 1-3-45所示，然后单击“OK”按钮弹出如图 1-3-46所示的保存快照的进度窗口。 

   

图 1-3-45  创建快照                          图 1-3-46  快照正在保存 

2．还原快照。 
使用“VM”→“Snapshot”→“Revert to Snapshot”命令还原最近的快照，或者在

此菜单中选择快照名称。如果已经创建多个快照，需还原某一个快照，可以通过“VM” 
→“Snapshot”→“Snapshot Manager”命令，或者使用工具按钮打开快照管理器进行
快照的创建和还原，如图 1-3-47所示。 

 

图 1-3-47  快照管理器 

【任务拓展】 

一、理论题 

1．什么是虚拟机快照？创建快照有何意义？ 

 

图 1-3-44  VMware Workstation 

快照按钮功能 
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2．VMware Workstation快照功能的作用是什么？ 
3．如果有多个快照，使用还原快照按钮将会还原到哪个快照？ 

二、实训 

1．为某一台虚拟机创建不同时间的多个快照。 
2．还原至最近一次快照。 
3．将虚拟机还原至任意的快照。 
 

电子
工业
出版
社版
权所
有 

   
   
 盗
版必
究




